15. The Interaction module

You can use the Interaction module to define and manage the following objects:

- Mechanical and thermal interactions between regions of a model or between a region of a model and its surroundings.
- Analysis constraints between regions of a model.
- Connectors between two points of a model or between a point of a model and ground.
- Inertia (point mass, rotary inertia, and heat capacitance) on regions of the model.
- Cracks on regions of the model.
- Springs and dashpots between two points of a model or between a point of a model and ground.

This chapter covers the following topics:

- “Understanding the role of the Interaction module,” Section 15.1
- “Entering and exiting the Interaction module,” Section 15.2
- “Understanding interactions,” Section 15.3
- “Understanding interaction properties,” Section 15.4
- “Understanding constraints,” Section 15.5
- “Understanding connectors,” Section 15.6
- “Understanding connector properties,” Section 15.7
- “Understanding Interaction module managers and editors,” Section 15.8
- “Understanding symbols that represent interactions, constraints, and connectors,” Section 15.9
- “Using the Interaction module toolbox,” Section 15.10
- “Using the Interaction module,” Section 15.11
- “Using the interaction editors,” Section 15.12
- “Using the constraint editors,” Section 15.13
- “Using the connector property editors,” Section 15.14

15.1 Understanding the role of the Interaction module

You can use the Interaction module to define the following:

- Contact interactions.
- Elastic foundations.
- Thermal film conditions.
- Radiation to and from the ambient environment.
- A user-defined actuator/sensor interaction.
- Tie constraints.
- Rigid body constraints.
- Display body constraints.
- Coupling constraints.
- Shell-to-solid coupling constraints.
- Embedded region constraints.
- Equation constraints.
- Connectors.
- Inertia.
- Cracks.
Springs and dashpots.

Interactions are step-dependent objects, which means that when you define them, you must indicate in which steps of the analysis they are active. (For more information about step-dependent objects, see “Understanding the status of an object in a step,” Section 3.4.4.) For example, you can define film and radiation conditions on a surface only during a heat transfer, coupled temperature-displacement, or coupled thermal-electrical step. Similarly, you can define an interaction with a user-defined actuator/sensor only during the initial step.

The Set and Surface toolsets in the Interaction module allow you to define and name regions of your model to which you would like interactions and constraints applied. You can use the Amplitude toolset to define variations in some interaction attributes over the course of the analysis. You can use the Reference Point toolset to define reference points that are used in constraints and connectors. ABAQUS/CAE does not recognize mechanical contact between part instances or regions of an assembly unless that contact is specified in the Interaction module; the mere physical proximity of two surfaces in an assembly is not enough to indicate any type of interaction between the surfaces.

For information on defining cracks, see “Modeling fracture mechanics,” Section 20.1.

For information on defining inertia, see “Modeling inertia,” Section 20.2. For information on defining springs and dashpots, see “Modeling springs and dashpots,” Section 20.4.

For information on related topics, click any of the following items:

- Chapter 39, “The Amplitude toolset”
- Chapter 46, “The Reference Point toolset”
- Chapter 48, “The Set and Surface toolsets”

You can enter the Interaction module at any time during an ABAQUS/CAE session by clicking Interaction in the Module list located under the toolbar. Interaction, Constraint, Connector, Special, Feature, and Tools menus appear on the main menu bar; and a Step list appears under the toolbar.

To exit the Interaction module, click another module in the Module list. You need not take any specific action to save objects created in the Interaction module before exiting the module; they are saved automatically when you save the entire model by selecting File→Save or File→Save As from the main menu bar.

You can use the Interaction module to define the following types of interactions:

Surface-to-surface contact and self-contact
Surface-to-surface contact interactions describe contact between two deformable surfaces or between a deformable surface and a rigid surface. Self-contact interactions describe contact between different areas on a single surface. For detailed instructions on creating these types of interactions, see “Defining surface-to-surface contact,” Section 15.12.1, and “Defining self-contact,” Section 15.12.2. For more information, see “Defining contact pairs in ABAQUS/Standard,” Section 21.2.1 of the ABAQUS Analysis User's Manual, and “Defining contact pairs in ABAQUS/Explicit,” Section 21.4.1 of the ABAQUS Analysis User's Manual.

If your model includes complex geometries and numerous contact interactions, you may want to customize the variables that control the contact algorithms to obtain cost-effective solutions. These controls are intended for advanced users and should be used with great care. For more information, see “Contact controls editors,” Section 15.8.4.

General contact (ABAQUS/Explicit only)

General contact interactions allow you to define contact between many or all regions of the model with a single interaction. Typically, general contact interactions are defined for an all-inclusive surface that contains all exterior faces, shell perimeter edges, and edges based on beams and trusses in the model. To refine the contact domain, you can include or exclude specific surface pairs. Unlike surface-to-surface contact or self-contact interactions, surfaces used in general contact interactions can span many disconnected regions of the model. Attributes, such as contact properties, surface properties, and contact formulation, are assigned as part of the contact interaction definition but independently of the contact domain definition, which allows you to use one set of surfaces for the domain definition and another set of surfaces for the attribute assignments. For detailed instructions on creating this type of interaction, see “Defining general contact,” Section 15.12.5.

For more information, see “Contact interaction analysis: overview,” Section 21.1.1 of the ABAQUS Analysis User's Manual, and “Defining general contact interactions,” Section 21.3.1 of the ABAQUS Analysis User's Manual. The assignment of a penalty stiffness scale factor is not supported in ABAQUS/CAE. In addition, node-based surfaces cannot be used in a general contact interaction in ABAQUS/CAE.

Elastic foundation (ABAQUS/Standard only)

Elastic foundations allow you to model the stiffness effects of a distributed support on a surface without actually modeling the details of the support. You can create elastic foundation interactions only in the initial step. Once an elastic foundation is activated, you cannot deactivate it in later analysis steps. For detailed instructions on creating this type of interaction, see “Defining foundations,” Section 15.12.9. For more information, see “Element foundations,” Section 2.2.2 of the ABAQUS Analysis User's Manual.

Thermal film conditions

Film condition interactions define heating or cooling due to convection by surrounding fluids. Two types of film condition interaction are available in ABAQUS/CAE: surface film conditions define convection from model surfaces, and concentrated film conditions define convection from nodes or vertices. You can define film condition interactions only during a heat transfer, fully coupled thermal-stress, or coupled thermal-electrical step. For detailed instructions on defining these types of interactions, see “Defining a surface convective interaction,” Section 15.12.10, and “Defining a concentrated convective interaction,” Section 15.12.11, respectively. For more information, see “Thermal loads,” Section 19.4.4 of the ABAQUS Analysis User's Manual.

Radiation to and from the ambient environment

Radiation interactions describe heat transfer to a nonreflecting environment due to radiation. Two types of radiation interactions are available in ABAQUS/CAE: surface radiation interactions describe heat transfer with a nonconcave surface, and concentrated radiation interactions describe radiation from nodes or vertices. You can define radiation interactions only during a heat transfer, fully coupled thermal-stress, or coupled thermal-electrical step. For detailed instructions on creating these types of interactions, see “Defining a surface radiative interaction,” Section 15.12.12, and “Defining a concentrated radiative interaction,” Section 15.12.13, respectively. For more information, see “Thermal loads,” Section 19.4.4 of the ABAQUS Analysis User's Manual.

Actuator/sensor (ABAQUS/Standard only)

An actuator/sensor interaction models a combination of sensors and actuators and, therefore, allows for modeling control system components. Currently, this type of interaction allows sensing and actuation at just one point. For detailed instructions on creating this type of interaction, see “Defining an actuator/sensor interaction,” Section 15.12.14. The interaction definition and its optional associated property are used to define the basic aspects of the interaction, but the user must provide user subroutine UEL to supply the specific formulae for how actuation depends on sensor readings. You specify the name of the file containing the user subroutine when you create the analysis job in the Job module.
Warning: This feature is intended for advanced users only. Its use in all but the simplest test examples will require considerable coding by the user/developer. “User-defined elements,” Section 18.15.1 of the ABAQUS Analysis User's Manual, should be read before proceeding.


For information on related topics, click the following item:


ABAQUS/CAE User's Manual

15.4 Understanding interaction properties

You can define a set of data that is referred to by an interaction but is independent of the interaction; for example, the coefficients that define friction during contact. This set of data is called an interaction property. One interaction property can be referred to by many different interactions.

You can create the following types of interaction properties:

Contact
A contact interaction property can define tangential behavior (friction and elastic slip) and normal behavior (hard, soft, or damped contact and separation). In addition, a contact property can contain information about damping, thermal conductance, thermal radiation, and heat generation due to friction. A contact interaction property can be referred to by a general contact, surface-to-surface contact, or self-contact interaction.

Film condition
A film condition interaction property defines a film coefficient as a function of temperature and field variables. A film condition interaction property can be referred to only by a film condition interaction.

Actuator/sensor
An actuator/sensor interaction property provides the PROPS, JPROPS, NPROPS, and NJPROPS variables that are passed into a UEL user subroutine used with an actuator/sensor interaction.

ABAQUS/CAE User's Manual

15.5 Understanding constraints

Constraints defined in the Interaction module define constraints on the analysis degrees of freedom, whereas constraints defined in the Assembly module define constraints only on the initial positions of instances. In the Interaction module you can constrain the degrees of freedom between regions of a model. Currently, you can create the following types of constraints:

Tie
A tie constraint allows you to fuse together two regions even though the meshes created on the surfaces of the regions may be dissimilar. For detailed instructions on creating this type of constraint, see “Defining tie constraints,” Section 15.13.1. For more information, see “Mesh tie constraints,” Section 20.3.1 of the ABAQUS Analysis User's Manual.

Rigid body
A rigid body constraint allows you to constrain the motion of regions of the assembly to the motion of a reference point. The relative positions of the regions that are part of the rigid body remain constant throughout the analysis. For detailed instructions on creating this type of constraint, see “Defining rigid body constraints,” Section 15.13.2. For more information on reference points, see Chapter 46, “The Reference Point toolset.” For more information, see “Rigid body definition,” Section 2.4.1 of the ABAQUS Analysis User's Manual.
Display body
A display body constraint allows you to select a part instance that will be used for display only. You do not have to mesh the part instance, and it is not included in the analysis; however, when you view the results of the analysis, the Visualization module displays the selected part instance. You can constrain the part instance to be fixed in space, or you can constrain it to follow selected nodes. You can apply a display body constraint to an instance of an ABAQUS native part or to an instance of an orphan mesh part. For detailed instructions on creating this type of constraint, see “Defining display body constraints,” Section 15.13.3. You can customize the appearance of display bodies in the Visualization module; for more information, see “Customizing the appearance of display bodies,” Section 37.8. A display body constraint is especially useful for mechanism or multibody dynamic problems where rigid parts interact with each other via connectors. In such cases you can create a simple rigid part, such as a point part, and a display body that is more representative of the physical part. For an example of a model that includes a display body constraint combined with connectors, see “Modeling display bodies,” Section 21.5. You can also use display bodies to model stationary objects that are not involved in the analysis but that help you to visualize the results. For more information, see “Display body definition,” Section 2.8.1 of the ABAQUS Analysis User's Manual.

Coupling
A coupling constraint allows you to constrain the motion of a surface to the motion of a single point. For detailed instructions on creating this type of constraint, see “Defining coupling constraints,” Section 15.13.4. For more information, see “Coupling constraints,” Section 20.3.2 of the ABAQUS Analysis User's Manual.

Shell-to-solid coupling
A shell-to-solid coupling constraint allows you to couple the motion of a shell edge to the motion of an adjacent solid face. For detailed instructions on creating this type of constraint, see “Defining shell-to-solid coupling constraints,” Section 15.13.5. For more information, see “Shell-to-solid coupling,” Section 20.3.3 of the ABAQUS Analysis User's Manual.

Embedded region
An embedded region constraint allows you to embed a region of the model within a “host” region of the model or within the whole model. For detailed instructions on creating this type of constraint, see “Defining embedded region constraints,” Section 15.13.6. For more information, see “Embedded elements,” Section 20.4.1 of the ABAQUS Analysis User's Manual.

Equation
Equations are linear, multi-point equation constraints that allow you to describe linear constraints between individual degrees of freedom. For detailed instructions on creating this type of constraint, see “Defining equation constraints,” Section 15.13.7. For more information, see “Linear constraint equations,” Section 20.2.1 of the ABAQUS Analysis User's Manual.

15.6 Understanding connectors
Connectors allow you to model a connection between two points in an assembly or between a point in an assembly and ground. You specify a connector property and local orientations associated with the connector points to define the function of a connector. For more information on connectors in ABAQUS/CAE, including an overview and an example of connector modeling, see “Modeling connectors,” Section 21.3.

For information on related topics, click the following item:

15.7 Understanding connector properties

15. The interaction module
Connector properties are referred to by connectors. The connector property defines the connection type and may include connector behavior data. A connector property can be referred to by many different connectors. The following topics are covered:

- “Connection types,” Section 15.7.1
- “Connector behaviors,” Section 15.7.2
- “What types of friction models are available?,” Section 15.7.3

15.7.1 Connection types

Table 15–1 summarizes the connection types available when creating connector properties. You can define basic and assembled connection types.

<table>
<thead>
<tr>
<th>Basic Types</th>
<th>Assembled Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translational</td>
<td>Rotational</td>
</tr>
<tr>
<td>Axial</td>
<td>Align</td>
</tr>
<tr>
<td>Cartesian</td>
<td>Cardan</td>
</tr>
<tr>
<td>Join</td>
<td>Constant Velocity</td>
</tr>
<tr>
<td>Link</td>
<td>Euler</td>
</tr>
<tr>
<td>Proj. Cartesian</td>
<td>Flexion-Tors.</td>
</tr>
<tr>
<td>Radial-Thrust</td>
<td>Proj. Flex-Tors.</td>
</tr>
<tr>
<td>Slide-Plane</td>
<td>Revolute</td>
</tr>
<tr>
<td>Slot</td>
<td>Rotation</td>
</tr>
<tr>
<td></td>
<td>Universal</td>
</tr>
<tr>
<td></td>
<td>Weld</td>
</tr>
</tbody>
</table>

Basic types

Basic connection types include translational types and rotational types. Translational types affect translational degrees of freedom at both connector points and may affect rotational degrees of freedom at the first point. Rotational types affect only rotational degrees of freedom at both connector points. You can use a single basic connection type (translational or rotational) or one translational and one rotational type.

Assembled types

Assembled connection types are predefined combinations of basic connection types. For a description of each connection type and the equivalent basic connection types that define the kinematic constraints of assembled type connections, see “Connection-type library,” Section 17.1.5 of the ABAQUS Analysis User's Manual.

15.7.2 Connector behaviors

You can apply connector behaviors to connection types that have available components of relative motion. Available components of relative motion are displacements and rotations that are not kinematically constrained. Multiple connector behaviors can be defined in a connector property. You can specify the following connector behaviors:

- Elasticity: Define spring-like elastic behavior.
- **Damping**: Define dashpot-like damping behavior.
- **Friction**: Define Coulomb-like and hysteretic friction using predefined or user-defined friction models.
- **Plasticity**: Define plastic behavior.
- **Damage**: Define damage initiation and evolution behavior (ABAQUS/Explicit analyses only).
- **Stop**: Define limit values of the admissible range of positions.
- **Lock**: Specify a user-defined locking criterion.
- **Failure**: Define limit values for force, moment, or position (ABAQUS/Explicit analyses only).
- **Reference Length**: Define the translational or angular positions at which constitutive forces and moments are zero.
- **Integration**: Specify implicit or explicit time integration for elasticity, damping, and friction (ABAQUS/Explicit analyses only).

For detailed instructions on defining connector behaviors, see “Using the connector property editors,” Section 15.14. For more information on connector behaviors, see “Connector behavior,” Section 17.2.1 of the ABAQUS Analysis User's Manual.

---

**15.7.3 What types of friction models are available?**

You can model predefined or user-defined friction behavior. For predefined friction you specify a set of geometric quantities that are characteristic of the connection type for which friction is modeled. In addition, you can define internal contact force contributions, such as prestress from the connection. ABAQUS automatically defines the contact force contributions and the local tangent directions along which friction occurs.

You can model predefined friction for the following connection types:

**Assembled types**
- Cylindrical (Slot + Revolute)
- Hinge (Join + Revolute)
- Planar (Slide-Plane + Revolute)
- Translator (Slot + Align)
- U Joint (Join + Universal)

**Basic types**
- Slide-Plane
- Slot

Predefined friction is also available if you define a combined translational and rotational connection type that is equivalent to one of these assembled types. You can define only one friction behavior for a given connection type if you are modeling predefined friction. If a predefined friction model is not available or does not adequately describe the mechanism being analyzed, you can specify a user-defined friction model. You can specify the tangent direction in which friction forces or moments are applied and define internal contact force contributions. You may use several connector friction behaviors to represent the frictional effects in the connector.

For detailed instructions on defining friction, see “Defining friction,” Section 15.14.3. For more information, see “Connector friction behavior,” Section 17.2.5 of the ABAQUS Analysis User's Manual.

---

**15.9 Understanding symbols that represent interactions, constraints, and connectors**

When you apply interactions, constraints, or connectors to regions of the model, you can choose to display symbols in the viewport that indicate where you have applied the interaction, constraint, or connector. For information about graphical symbol types, see “Symbols used to represent interactions, constraints, and connectors,” Section B.2.
You can apply interactions, constraints, and connectors to native geometry or to an orphan mesh.

**Interactions and constraints**

If you apply an interaction or constraint to native geometry, symbols appear approximately equally spaced over the surface or surfaces to which the interaction or constraint is applied. If the interaction or constraint definition involves a node region rather than a surface, the symbols appear equally spaced on the edges of the node region and at any vertices in the node region. If the interaction or constraint is applied to a single vertex, a symbol appears at that vertex.

If you apply the interaction or constraint to an orphan mesh, symbols appear at the center of each element face for surface-based regions or at the nodes for node-based regions.

**Connectors**

If you define a connector using two connector points, the connector sphere symbol and orientation triad appear at the connector points. The connection type label appears midway along a line between the connector points. If you define a connector with either connector point connected to ground, the connector sphere symbol, orientation triad, and connection type label appear at the specified connector point.

For information about controlling the visibility of these symbols, see “Controlling the display of attributes,” Section 50.11. For information on symbols representing prescribed conditions, see “Understanding symbols that represent prescribed conditions,” Section 16.5.

**15.10 Using the Interaction module toolbox**

You can access all the Interaction module tools through either the main menu bar or the Interaction module toolbox. Figure 15–10 shows the icons for all the load tools in the Interaction module toolbox.

**Figure 15–10** The Interaction module toolbox.

**15.11 Using the Interaction module**

This section describes in detail how to use different features of the Interaction module. The following topics are covered:

- “Creating interactions,” Section 15.11.1
- “Creating interaction properties,” Section 15.11.2
- “Specifying contact property options,” Section 15.11.3
- “Customizing contact controls,” Section 15.11.4
- “Creating constraints,” Section 15.11.5
- “Creating and modifying connectors,” Section 15.11.6
- “Creating connector properties,” Section 15.11.7
- “Editing the region to which an interaction or constraint is applied,” Section 15.11.8
You can create the following interactions:

- Contact.
- Elastic foundations.
- Heat flux on a surface or a point due to convection.
- Heat flux on a surface or a point due to radiation to the environment.
- Interactions between a point and a user-defined actuator/sensor element.

The available categories and types of interactions depend on the procedure selected for the step. For example, you can define heat flux on a surface only during a heat transfer, coupled temperature-displacement, or coupled thermal-electrical step. Similarly, you can define interactions with a user-defined actuator/sensor only during the initial step.

To create interactions:

1. From the main menu bar, select Interaction→Create.

   **Tip:** You can also create an interaction using the tool in the Interaction module toolbox.

2. In the Create Interaction dialog box that appears, do the following:
   - Name the interaction. For more information about naming objects, see “Using basic dialog box components,” Section 3.2.1.
   - Select the step in which the interaction will be created.
   - Select the interaction type.

3. Click Continue to create the interaction and to close the Create Interaction dialog box.

4. Select the region to which to apply the interaction (not applicable to general contact interactions). For more information, see Chapter 6, “Selecting objects within the viewport.”

5. In the editor that appears or, if applicable, in the prompt area, enter any data necessary to define the interaction.

For detailed instructions on creating different types of interactions, see the following sections:

- “Defining surface-to-surface contact,” Section 15.12.1
- “Defining self-contact,” Section 15.12.2
- “Defining general contact,” Section 15.12.5
- “Defining foundations,” Section 15.12.9
- “Defining a surface convective interaction,” Section 15.12.10
- “Defining a surface radiative interaction,” Section 15.12.12
- “Defining an actuator/sensor interaction,” Section 15.12.14

For information on related topics, click any of the following items:

- “What are step-dependent managers?,” Section 3.4.2
- “Understanding and using toolboxes,” Section 3.3
- Chapter 6, “Selecting objects within the viewport”
- Chapter 48, “The Set and Surface toolsets”
15.11.2 Creating interaction properties

You can create an interaction property by entering data in an interaction property editor. The format of the editor varies according to the type of property you are defining; when you create a property, you must first specify the property type so that the appropriate editor appears. For more information, see “Understanding interaction properties,” Section 15.4.

To create an interaction property:

1. From the main menu bar, select Interaction→Property→Create.

   Tip: You can also create an interaction property using the tool in the Interaction module toolbox.

   A Create Interaction Property dialog box appears.

2. Enter a property name. For more information about naming objects, see “Using basic dialog box components,” Section 3.2.1.

3. Select the property type, and click Continue.

   The editor for the property type you have specified appears.

4. In the editor, enter all of the data necessary to define the interaction property.

   Note: You can display help on a particular editor feature by selecting Help→On Context from the main menu bar and then clicking the editor feature of interest.

5. Click OK to save the data and to exit the editor.

For information on related topics, click any of the following items:

- “Understanding interaction properties,” Section 15.4
- “Interaction property editors,” Section 15.8.3
- “Specifying contact property options,” Section 15.11.3

ABAQUS/CAE User's Manual

15.11.3 Specifying contact property options

The contact property editor contains menus from which you can choose options to include in the property definition. The Contact Property Options list at the top of the editor displays the options currently included in the property definition; the list is updated as you add and delete options.

You can add, delete, or change property options as follows:

Adding property options

Select the options needed to define your property from the Mechanical and Thermal menus. When you select an option, its name appears in the Contact Property Options list, and data fields associated with the option appear in the data area in the bottom half of the editor. Use the data fields to enter information for the currently selected option.

Deleting property options

In the Contact Property Options list, select the option that you want to delete, and click Delete on the right side of the editor. This procedure removes the option from both the options list and the property definition.

Changing option data

In the Contact Property Options list, select the option whose data you want to change. When the data fields associated with the option appear in the bottom half of the window, change the information that you have entered for the option as desired.

For information on related topics, click the following item:

- “Interaction property editors,” Section 15.8.3
15.11.4 Customizing contact controls

The contact controls editors allow you to modify the algorithms used to enforce contact conditions. The default contact controls are usually sufficient, but customizing these controls may result in a more cost-effective solution.

Warning: Contact controls are intended for advanced users. The default settings of these controls are appropriate for most analyses. Using nondefault values of these controls may greatly increase the computational time of the analysis or produce inaccurate results. Changing these settings in an ABAQUS/Standard analysis may also cause convergence problems.

To customize contact controls:

1. From the main menu bar, select Interaction ➔ Contact Controls ➔ Create.
2. In the Create Contact Controls dialog box that appears, do the following:
   - Name the contact controls.
   - Select ABAQUS/Standard contact controls or ABAQUS/Explicit contact controls.
3. Click Continue.
   The editor for the type of contact controls that you specified appears.
4. In the editor, enter the data necessary to customize the contact controls. For detailed instructions, see the following sections:
   - “Specifying contact controls in an ABAQUS/Standard analysis,” Section 15.12.3
   - “Specifying contact controls in an ABAQUS/Explicit analysis,” Section 15.12.4
5. If you want to reset the values in the editor to the default values, click Defaults at the bottom of the editor.
6. Click OK to save your customized settings and to exit the editor.

15.11.5 Creating constraints

You can create the following constraints:

- Tie constraints that tie two separate surfaces together so that there is no relative motion between them.
- Rigid body constraints that allow you to designate a collection of regions as a rigid body.
- Display body constraints that allow you to designate a part instance that will be used for display only.
- Coupling constraints that allow you to constrain the motion of a surface to the motion of a single point.
- Shell-to-solid coupling constraints that allow you to couple the motion of a shell edge to the motion of an adjacent solid face.
- Embedded region constraints that allow you to embed a region of the model within a "host" region of the model or within the whole model.
- Equation constraints that describe linear constraints between individual degrees of freedom.

To create constraints:

1. From the main menu bar, select Constraint ➔ Create.

*Tip:* You can also create a constraint using the tool in the Interaction module toolbox.

2. In the Create Constraint dialog box that appears, do the following:
   a. Name the constraint. For more information about naming objects, see “Using basic dialog box components,” Section 3.2.1.
   b. Select the desired constraint type, and then click Continue.
3. Click Continue to create the constraint and to close the Create Constraint dialog box.
4. If applicable, select the region to which to apply the constraint. For more information, see Chapter 6, “Selecting objects within the viewport.”
5. In the editor that appears, enter any data necessary to define the constraint.

For detailed instructions on creating different types of constraints, see the following sections:

- “Defining tie constraints,” Section 15.13.1
- “Defining rigid body constraints,” Section 15.13.2
- “Defining display body constraints,” Section 15.13.3
- “Defining coupling constraints,” Section 15.13.4
- “Defining shell-to-solid coupling constraints,” Section 15.13.5
- “Defining embedded region constraints,” Section 15.13.6
- “Defining equation constraints,” Section 15.13.7

For information on related topics, click any of the following items:

- “Understanding and using toolboxes,” Section 3.3
- Chapter 6, “Selecting objects within the viewport”
- Chapter 48, “The Set and Surface toolsets”

---

ABAQUS/CAE User's Manual

15.11.6 Creating and modifying connectors

You can create connectors between two points in an assembly or between a point in the assembly and ground. When you create a connector between a point in the assembly and ground, you can specify that you want to connect either point of the connector, but not both, to ground.

**To create and edit connectors:**

1. Display the connector editor using one of the following methods:
   - To create a new connector, select **Connector** → **Create** from the main menu bar.
     
     **Tip:** You can also create a connector using the tool in the Interaction module toolbox.

     In the **Create Connector** dialog box that appears, name the connector and click **Continue**. For more information about naming objects, see “Using basic dialog box components,” Section 3.2.1.

     The connector editor appears.
   - To edit an existing connector, select **Connector** → **Manager** from the main menu bar to display the **Connector Manager**. Select the name of the connector, and click **Edit**.
     
     **Tip:** You can also initiate this procedure from the **Connector** menu in the main menu bar by selecting **Edit** → **connector name**.

     The connector editor appears, and the connector symbol becomes highlighted in the current viewport.

2. In the **Edit Connector** dialog box, select a connector property. If desired, click **Create** to create a new connector property. The connection type is displayed in the dialog box; you can click **Show diagram** to see a schematic drawing of the connection type along with the ABAQUS idealization of the connection.

3. Click **Edit Point 1** to select the first connector point using one of the following methods:
   - Select a point in the viewport.
     
     **Tip:** The **Select the Entity Closest to the Screen** tool in the **Options** toolbox is toggled off by default. If you make an ambiguous selection, ABAQUS/CAE highlights the point and displays a description of the point in the lower left corner of the viewport. Use the **Next** and **Previous** buttons to cycle through the possible selections, and click **OK** to confirm your selection.

     The selected point is highlighted red in the viewport.
   - Click **Connect to Ground** to fix the displacements and rotations of the first connector point. You can specify only one connector point to ground.
The connector editor reappears and displays a description of the selected point.

4. Click **Edit Point 2** to select the second connector point using one of the following methods:
   - Select a point in the viewport.

   **Tip:** The [Select the Entity Closest to the Screen](#) tool in the **Options** toolbox is toggled off by default. If you make an ambiguous selection, ABAQUS/CAE highlights the point and displays a description of the point in the lower left corner of the viewport. Use the **Next** and **Previous** buttons to cycle through the possible selections, and click **OK** to confirm your selection.
   
   The selected point is highlighted magenta in the viewport.

   - Click **Connect to Ground** to fix the displacements and rotations of the second connector point. You can specify only one connector point to ground.

   The connector editor reappears and displays a description of the selected point.

5. Depending upon the connection type, a local orientation for the first connector point is required, optional, or not applicable. Click **Edit Orientation 1** to specify a local orientation for the first connector point using one of the following methods:
   - Select a predefined datum coordinate system by name.
     a. From the prompt area, click **Datum CSYS List** to display a list of datum coordinate systems.
     b. Select a name from the list, and click **OK**.
   
   **Tip:** The [Select the Entity Closest to the Screen](#) tool in the **Options** toolbox is toggled off by default. For coordinate systems with coincident origins, when you cycle through all of the possible selections, ABAQUS/CAE highlights the coordinate system and displays the description of the coordinate system in the viewport.
   
   - From the prompt area, click **Unselect CSYS** to unselect the previously selected local orientation.
   
   The selected orientation is highlighted red in the viewport. The connector editor reappears and displays a description of the coordinate system used for the orientation of the first connector point.

6. Depending upon the connection type, a local orientation for the second connector point is optional or not applicable. If the orientation is optional, ABAQUS/CAE uses the orientation for the first connector point as the default selection. Click **Edit Orientation 2** to specify a local orientation for the second connector point using one of the following methods:
   - Select a predefined datum coordinate system by name.
     a. From the prompt area, click **Datum CSYS List** to display a list of datum coordinate systems.
     b. Select a name from the list, and click **OK**.
   
   **Tip:** The [Select the Entity Closest to the Screen](#) tool in the **Options** toolbox is toggled off by default. For coordinate systems with coincident origins, when you cycle through all of the possible selections, ABAQUS/CAE highlights the coordinate system and displays the description of the coordinate system in the viewport.
   
   - From the prompt area, click **Unselect CSYS** to return to the default selection.
   
   The selected orientation is highlighted magenta in the viewport. The connector editor reappears and displays a description of the coordinate system used for the orientation of the second connector point.

7. Click **OK** to save your connector definition and to close the editor.

For information on related topics, click any of the following items:

- “Understanding connectors,” Section 15.6
- “Connector editors,” Section 15.8.6
- “Modeling connectors,” Section 21.3
15.11.7 Creating connector properties

You can create a connector property by selecting connection types to define the connector function. The connector property editor allows you to specify behaviors to include in the property definition. The Behavior Options list at the top of the editor displays the behaviors included in the connector property definition; the list is updated as you add and delete behaviors.

To create a connector property:

1. From the main menu bar, select Connector→Property→Create.

   Tip: You can also create a connector property using the tool in the Interaction module toolbox.

   A Create Connector Property dialog box appears.

2. Enter a property name. For more information about naming objects, see “Using basic dialog box components,” Section 3.2.1.

3. Choose one of the following connection types:
   - Choose Assembled types to use predefined combinations of basic connection types.
     Click the arrow next to the Assembled type text field, and select the desired connection type from the list that appears.
   - Choose Basic types to use translational and rotational connection types.
     a. If desired, click the arrow next to the Translational type text field, and select the connection type from the list that appears.
     b. If desired, click the arrow next to the Rotational type text field, and select the connection type from the list that appears.

   You can select one translational type, one rotational type, or one translational and one rotational type to define the connector property.

4. ABAQUS/CAE displays the available and constrained components of relative motion (CORM) for the connection type that you have selected. In addition, you can click Show diagram to see a schematic drawing of the connection type along with the ABAQUS idealization of the connection.

5. For a description of assembled and basic connection types, see “Connection-type library,” Section 17.1.5 of the ABAQUS Analysis User's Manual.

6. Click Continue.

   The connector property editor appears.

7. In the editor, you can edit the connection type and add, delete, and change behaviors as follows:

   **Editing the connection type**
   Click Edit to the right of the connection type to display the connector property type editor. Select the connection type as described above. You must delete all behaviors from the editor before you can edit the connection type.

   **Adding behaviors**
   Click Add on the right side of the editor to display a list of available behaviors. Select the behaviors needed to define your connector property. You can define multiple behaviors of the same type for some behaviors. When you select a behavior, its name appears in the Behavior Options list, and data fields associated with the behavior appear in the data area in the bottom half of the editor. Use the data fields to enter information for the currently selected behavior. For more information, see “Using the connector property editors,” Section 15.14.

   **Deleting behaviors**
   In the Behavior Options list, select the behavior that you want to delete, and click Delete on the right side of the editor. This procedure removes the behavior from both the behavior options list and the connector property definition.

   **Changing behavior data**
   In the Behavior Options list, select the behavior whose data you want to change. When the data fields associated with the behavior appear in the bottom half of the window, change the information that you have entered for the behavior as desired.

   Note: You can display help on a particular editor feature by selecting Help→On Context from the main menu bar and then clicking the editor feature of interest or see “Using the connector property editors,” Section 15.14.

8. Click OK to save the data and to exit the editor.
15.11.8 Editing the region to which an interaction or constraint is applied

You can edit the region to which an interaction is applied only in the step in which the interaction was created.

**To edit the region to which an interaction or constraint is applied:**

1. From the Interaction or Constraint menu in the main menu bar, select Manager to display the Interaction Manager or Constraint Manager.
2. Choose one of the following methods:
   - To edit an interaction, click the cell located in the row of the interaction that you want to modify and in the column of the step in which it was created and click Edit. Alternatively, you can just double-click the cell.
     **Tip:** You can also initiate this procedure by clicking the step in which the interaction was created from the Step list located under the toolbar. From the Interaction menu in the main menu bar, select Edit interaction name.
   - To edit a constraint, select the name of the constraint and click Edit.
     **Tip:** You can also initiate this procedure by selecting Edit constraint name from the main menu bar.
3. If you are editing a foundation interaction, either you are prompted to edit the region by selecting or unselecting objects in the viewport or a Region Selection dialog box appears in which you can select a surface that you have already created using the Surface toolset.
4. If you are editing any other type of interaction or a constraint, the appropriate editor appears. The editor for all interactions except general contact contains an Edit Region button for each region involved in the interaction or constraint definition.
5. If your interaction or constraint definition includes both a master surface and a slave surface or region, the master surface appears highlighted in red and the slave surface or region appears highlighted in magenta during the editing procedure.
6. If you are editing a general contact interaction, modify the contact domain using the methods described in “Defining general contact,” Section 15.12.5.
7. If you are editing a constraint or an interaction other than general contact or foundation, click Edit Region for the region that you want to modify. For example, if you are editing a surface-to-surface contact interaction and you want to modify the master surface, click Edit Region next to the Master surface label in the editor.
8. If you are editing a constraint or an interaction other than general contact, edit the region by selecting and unselecting objects in the viewport. If you are editing the host region to which an embedded region constraint is applied, first select the selection method. When you have finished editing the region, click mouse button 2. (For more information, see Chapter 6, “Selecting objects within the viewport.”)

   **Tip:** You can limit the types of objects that you can select in the viewport by clicking the selection options tool in the prompt area and then clicking the selection filter of your choice in the dialog box that appears. See “Using the selection options,” Section 6.3, for more information.

If you would rather select from a list of existing sets or surfaces, do the following:

a. Click Sets or Surfaces on the right side of the prompt area. (The name of the button depends on the type of object you are editing. For example, if you are editing an interaction, a Surfaces button appears.)

   ABAQUS/CAE displays the Region Selection dialog box containing a list of available sets or surfaces.

b. Select the set or surface of interest, and click Continue.
Note: The default selection method is based on the selection method you most recently employed. To revert to the other method, click Select in Viewport or Sets or Surfaces on the right side of the prompt area.

9. Finish editing the interaction or constraint definition as desired, and then press mouse button 2 (if you are editing a foundation interaction) or click OK in the editor (if you are editing any other type of interaction or if you are editing a constraint).

For information on related topics, click any of the following items:
- “Using the Interaction module,” Section 15.11
- “What are step-dependent managers?,” Section 3.4.2

15.11.9 Using the Special menu in the Interaction module

You can use the Special menu in the Interaction module to define the following engineering features:
- **Inertia.** You can define lumped mass, rotary inertia, and heat capacitance at a point on an assembly. In an ABAQUS/Standard analysis you can also define mass and inertia proportional damping and composite damping. For more information, see “Modeling inertia,” Section 20.2.
- **Crack.** You can define an embedded seam crack with duplicate overlapping nodes, and you can include the seam crack in a contour integral analysis. You can also define a crack in an existing region and perform a contour integral analysis. For more information, see “Modeling fracture mechanics,” Section 20.1.
- **Springs/Dashpots.** You can define springs and dashpots that exhibit the same linear behavior independent of field variables. You can also define both spring and dashpot behavior on the same set of points. In an ABAQUS/Explicit or an ABAQUS/Standard analysis, you can model springs and dashpots that connect two points, following the line of action between the two points. In an ABAQUS/Standard analysis, you can also model springs and dashpots that connect two points, acting in a fixed direction, or that connect points to ground. For more information, see “Modeling springs and dashpots,” Section 20.4.

For information on related topics, click any of the following items:
- “Creating a seam,” Section 20.1.9
- “Defining data for contour integrals,” Section 20.1.11
- “Defining point mass and rotary inertia,” Section 20.2.3
- “Defining heat capacitance,” Section 20.2.5
- “Creating springs and dashpots connecting two points,” Section 20.4.3
- “Creating springs and dashpots connecting points to ground,” Section 20.4.5